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一、产品概述

1.1产品功能

网关 PM-127实现了串口和 PROFIBUS DP的数据通信。可连接多个具有Modbus RTU/ASCII（RS485）

接口的设备到 PROFIBUS DP 总线，也支持 DCS 等Modbus主站对现场 PLC 等 DP主站数据的采集和监控，

即实现Modbus/RS485网络设备与 PROFIBUS DP网络设备的数据通信。

1.2 产品特点

▼应用广泛：凡具有 RS485 接口的 Modbus RTU/ASCII 协议设备或系统都可以使用本产品实现与现场总线

PROFIBUS的互连。如：具有Modbus协议接口的变频器、电机启动保护装置、智能高低压电器、电量测量装

置、各种变送器、智能现场测量设备及仪表，DCS 系统或 PLC（Modbus主站）等等。

▼应用简单：用户不必了解 PROFIBUS和Modbus技术细节，用户只需参考本手册及提供的应用实例，根据

要求完成配置，不需要复杂编程，即可在短时间内实现连接通信。

▼透明通信：用户可以依照 PROFIBUS 通信数据区和Modbus通信数据区的映射关系，实现 PROFIBUS 到

Modbus之间的数据透明通信。

1.3技术指标

[1] PM-127 网关在 PROFIBUS侧是一个 PROFIBUS DP从站，在Modbus一侧是Modbus主、从站可设；通

过 PROFIBUS通信数据区和Modbus数据区的数据映射实现 PROFIBUS和Modbus的数据透明通信

[2] PM-127网关作为Modbus主站，支持 01H、02H、03H、04H、05H、06H、0FH、10H号功能码，最多可

配置 48条Modbus命令（PM-127 的Modbus命令在 PROFIBUS DP主站组态软件中配置，1条命令对应 1个

槽位。西门子 PLC 对应的组态软件 Step7、TIA Portal支持最大 50个槽位）支持监控Modbus命令状态功能；

输入数据多误清零或保持功能、输出数据超时重发功能

[3] PM-127网关作为 Modbus从站，支持Modbus寄存器地址 3区（3xxxx）、4区（4xxxx）、0区（0xxxx）

和 1区（1xxxx）；其中，3区支持功能码 04H；4区支持功能码 03H、06H、10H；0区支持功能码 01H、05H、

0FH；1区支持功能码 02H
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[4] 支持 PROFIBUS DP/V0协议和 DP/V1协议，符合 IEC61158 TYPE3 PROFIBUS国际标准、中国国家标准

GB/T 20540-2006

[5] PROFIBUS DP从站，波特率自适应，支持波特率范围：9600～12Mbps

[6] PROFIBUS 输入/输出字节数可通过 Step7或 TIA Portal等 DP主站自由设定，最大 PROFIBUS输入/输出：

①Max Input Bytes ≤244Bytes

②Max Output Bytes ≤244 Bytes

③Max Data Bytes ≤488 Bytes

[7] 控制功能：作为Modbus主站，PROFIBUS端可以允许和禁止Modbus命令的发送

[8] 状态监视功能：作为Modbus主站，PROFIBUS端可以监视Modbus命令状态；作为Modbus从站，PROFIBUS

端可以监视Modbus网络状态

[9] 监视 PROFIBUS端状态：作为Modbus从站，Modbus端可以监视 PROFIBUS端网络状态

[10] 自动降级功能：Modbus主站收发命令超时达到设定的次数后会触发该功能，使超时的命令由快速扫描降

级为慢速扫描，提高通信效率

[11]Modbus协议接口是 RS-485接口，半双工；波特率：300，600，1200，2400，4800，9600，19200，38400，

57600，115200bps可选；8位数据位；校验位(偶、奇、无、标记、空格)可选；停止位（1、2）可选

[12] 供电：24VDC（18V-30V），120mA（24V DC典型值）

[13] 隔离电源：串口 主数字电路 电源三方完全隔离，电源抗干扰能力强，安全性高。

[14] 工作环境温度：-40℃ ~ 70℃, 相对湿度 5% ~ 95%（无凝露）

[15] 外形尺寸：25mm（宽）×100mm（高）×90mm（深）

[16] 安装：35mm 导轨

[17] 防护等级：IP20

http://www.sibotech.net
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1.4电磁兼容性能

1.4.1高频干扰试验( GB/T15153.1 classⅢ )

施加场所

电源输入回路–对地

电源输入回路之间

交流输入回路–对地

施加波形

第 1波波高值

振荡频率

1/2衰减时间

重复频度

试验设备输出阻抗

2.5～3kV
1.0～1.5MHz

≥6μs
50回以上/s
150～200Ω

1.4.2快速瞬变脉冲群试验( GB/T17626.4 classⅢ )

电压峰值
电源输入和交流加入回路：2kV

弱电回路：1kV

重复频率 5 kHz

1.4.3静电放电干扰( GB/T 17626.2 classⅢ )

施加场所 通常运用时,操作者触及部分

电压、电流 6kV 接触放电，放电的第一个峰值电流 22.5A

次数 每处 1秒以上的间隔 10回以上

极性 正极性

1.4.4辐射电磁场( GB/T 17626.3 classⅢ )

电波频率 150MHz, 400MHz, 900MHz

试验场强 10 V/m

辐射方法 使得天线前端触碰装置,或接近端子,断续辐射电波

http://www.sibotech.net
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1.5 相关产品

本公司其它相关产品包括：

PM-160，PM-125等

获得以上几款产品的说明，请访问公司网站 www.sibotech.net，或者拨打技术支持热线：021-3126 5138。

1.6 术语

PROFIBUS DP：PROFIBUS DP协议

RS485：一种串口的硬件规范

PM-127：Modbus(RS485)/PROFIBUS DP网关

http://www.sibotech.net
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二、产品外观

2.1 产品外观

2.2指示灯

指示灯 状态 含义

STA
（PROFIBUS DP网络状态指示灯）

绿灯闪烁 PROFIBUS DP总线上有数据通信

绿灯灭 无数据通信

PBF
（PROFIBUS DP网络状态指示灯）

红灯常亮 PROFIBUS DP总线数据通信失败

红灯灭 数据通信正常

RX
（串口状态指示灯）

绿灯闪烁 串口接收有数据

绿灯灭 串口无接收数据

TX
（串口状态指示灯）

绿灯闪烁 串口发送有数据

绿灯灭 串口无发送数据

RS485接口

电源接口

PROFIBUS DP接口

通讯指示灯

终端电阻开关

显示数码管

PROFIBUS DP
地址与模式设置

按钮

http://www.sibotech.net
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2.3 数码管显示

PM-127正常工作状态下，数码常亮交替显示当前 PROFIBUS DP地址与模式。

不同模式下的显示情况：

1）DP/V1模式

三段分时显示，第一段显示百位“A0/A1”（分别表示百位为 1、百位为 0）、第二段显示地址后两位（十

位与个位）、第三段显示模式代号“-1”

（例：DP地址为 124，第一段显示“A1”,第二段显示“24”）

（例：DP地址为 63，第一段显示“A0”,第二段显示“63”）

2）DP/V0模式

三段分时显示，第一段显示百位“A0/A1”、第二段显示地址后两位、第三段显示模式代号“-0”

3）DP/V0兼容模式

三段分时显示，第一段显示百位“A0/A1”、第二段显示地址后两位、第三段显示模式代号“-C”

DP/V0模式与 DP/V0兼容模式的区别：

DP/V0模式可以兼容 V4.1和 V2.5版之间的产品（包括 V4.1与 V2.5），

DP/V0兼容模式用于兼容 V2.5版以下的产品（不包括 V2.5）。

2.4 设置按钮

按钮可以配置 PROFIBUS DP地址与模式

1）快速连续按两次（双击）按钮，数码管显示的地址百位开始闪烁、A常亮，单按按钮加 1，即可开始设置

PROFIBUS DP 地址的百位。长按按钮 2.5秒，数码管显示的十位开始闪烁、个位常亮，单按按钮加 1，即可

开始设置 PROFIBUS DP地址的十位。长按按钮 2.5秒，数码管显示的个位开始闪烁、十位常亮，单按按钮加

1，即可开始设置 PROFIBUS DP地址的个位。长按 2.5秒保存 DP地址。

2）长按按钮 5秒，数码管显示当前模式且闪烁，单击按钮可以修改模式。长按 2.5秒，保存模式。

http://www.sibotech.net
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注：进入设置状态后，如果十秒内没有按钮操作则自动退出设置状态，且恢复到原来设置。

PROFIBUS DP地址的可设置范围为：0~126；

设置流程示意图

2.5 通信端口

2.5.1电源端口和 RS-485端口

(1)电源接口

引脚 功能

1 GND，电源地

2 NC，无连接

3 24V+，直流正 24V

(2)RS-485接口

http://www.sibotech.net
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引脚 功能

1 D+，连接用户设备 RS-485数据+

2 D-，连接用户设备 RS-485数据-

3 GND

PM-127 产品的485 接口是标准的RS-485 接口，以下简述本产品RS-485 特性：

 RS-485 传输技术基本特征
① 网络拓扑：线性总线，两端有有源的总线终端电阻；

② 传输速率：1200 bit/s~115.2Kbit/s；

③ 介质：屏蔽双绞电缆，也可取消屏蔽，取决于环境条件（EMC）；

④ 站点数：每分段 32 个站（不带中继），可多到 127 个站（带中继）；

备注：PM-127 Modbus端作为主站实际连接从站设备的数量还受多方面的限制，如总的输入/输出字节数不能

超过 244/244字节，数据的更新速率需求（如果对实时性要求高，建议 PM-127连接的从站不超过 10个），总

的命令条数不能超过 48条等。

⑤ 插头连接：3针可插拔端子；每个端子旁边配有一个 120Ω终端电阻拨动开关：当开关开启时终端电

阻被连接；关闭时终端电阻被断开。

 RS-485 传输设备安装要点

① 全部设备均与 RS-485 总线连接；

② 总线的最远两端各有一个总线终端电阻，120Ω 1/2W 确保网络可靠运行。

串行接口采用开放式 3针可插拔端子，用户可以根据面板上的指示进行接线。

http://www.sibotech.net
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2.5.2PROFIBUS DP端口

PROFIBUS DP接口采用 DB9孔型接头，其引脚定义如下：

引脚 信号说明

3 PROFI_B，数据正（必接）

4 RTS

5 GND

6 +5V输出

8 PROFI_A，数据负（必接）

螺栓 SHIELD，总线电缆屏蔽地

其中 PROFI_B（引脚 3）、PROFI_A（引脚 8）和屏蔽地为必接；RTS（引脚 4）可以被一些设备用来决定传输

方向；+5V（引脚 6）和 GND（引脚 5）用于总线终端，也可以为光纤收发器供电，引脚 5和 6的最大输出电

流为 80mA。

http://www.sibotech.net
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三、快速应用指南

以下几个步骤可以快速应用您的 PM-127：

1. 给 PM-127上电，按照本说明书 2.4章节说明设置 PM-127的 PROFIBUS DP地址。

2. 把 GSD 文件导入到 PROFIBUS DP 组态软件中，PM-127 作为Modbus主站和从站时的 GSD 文件不同，

请根据需要导入正确的 GSD文件。

3. 在 PROFIBUS组态软件中，设置 PROFIBUS DP从站地址；根据您的需要配置Modbus通讯参数及读、写

命令，即将 PM-127相应的输入输出映射到 PLC 或其它 PROFIBUS主站设备的内存中。

注意：在组态 PM-127作为Modbus主站时，若需要使用控制字，则需将“Control Module”组态到读、

写数据块之前，若不需要使用控制字，则不组态“Control Module”即可。

4. 按照第二章 RS-485端口的说明，关闭电源，正确连接 3针端子的每个引脚的相应接线。

5. 按照第二章 PROFIBUS DP端口的说明，正确连接至少 3和 8两个引脚。

6. 连接好Modbus设备和 PROFIBUS DP通信线，给 PM-127上电，进入正常通信状态。

7. 当 PROFIBUS DP端通信正常，若使用了控制字功能，用户需将“Control Module”的对应位置 1 来允许

Modbus读写命令的发送。

http://www.sibotech.net
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四、PROFIBUS DP主站组态界面参数设置

4.1 参数设置说明

在 PROFIBUS DP 主站组态界面中需要设置的参数包括：PROFIBUS DP 从站属性参数、Modbus 命令

Module参数。

PROFIBUS DP从站属性参数包括Modbus通讯波特率、串口参数、响应等待时间、轮询延时时间、自动

降级功能以及Modbus从站地址（从站时有效）。

Modbus命令 Module 参数：当为Modbus主站时，Modbus命令Module 参数包括：从站地址、功能码、

起始地址以及数据个数。

4.2 参数设置步骤

4.2.1创建新工程

1. 打开 SIMATIC Manager ，如图 1：

图 1

2. 点击 File->New, 新建一个工程，如图 2：

http://www.sibotech.net
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图 2

3. Insert->Station->SIMATIC 300 Station.，如图 3：

图 3

http://www.sibotech.net
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4. 双击 SIMATIC 300(1)->Hardware，打开 S7 PLC 硬件组态界面，如图 4：

图 4
5. 弹出的组态界面如图 5所示，注册 GSD文件之前应该关闭当前工程的组态窗口。

http://www.sibotech.net
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图 5

4.2.2注册 GSD文件

PM-127作为Modbus主站和从站时的 GSD文件不同，请根据需要导入正确的 GSD文件。

1. 在图 5中关闭当前工程组态窗口后，点击菜单栏 Options->Install GSD file，如图 6：

图 6

2. 弹出如图 7 所示窗口，根据网关数码管显示选择对应版本的 SIB_127M.gsd 或者 SIB_127S.gsd，点击

“Install”，注册完后，单击“Close”，关闭注册窗口。

http://www.sibotech.net


www.sibotech.net 16

图 7

3. 在菜单栏中选择 Options->Update Catalog, 在 Device 目录中更新所注册的设备，您可以在右侧窗口

/PROFIBUS DP/Additional Field Devices/Converter/找到您注册的设备，如图 8所示：

http://www.sibotech.net
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图 8

4.2.3组态设置

1. 打开您创建工程的组态设置界面，设定 PLC rack，双击“Hardware Catalog\SIMATIC 300\RACK-300\Rail”，

如图 9所示：

http://www.sibotech.net
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图 9

2. 设定 CPU 模块，选择对应的设备类型和所占用的槽位；

3. 创建 PROFIBUS DP 网络，设置 PROFIBUS DP：New->Network settings，选择 DP，选择一个波特率如

187.5Kbps，然后 “OK”，双击它；如图 10：

http://www.sibotech.net
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图 10

4. 选择 PROFIBUS Master station 地址，如图 11：

http://www.sibotech.net
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图 11

5. 将从站 PM-127配入到 PROFIBUS 网络配置当中，并将输入输出数据块映射到 S7-300或者其它控制器的

内存当中，如图 12：

http://www.sibotech.net
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图 12

操作中分为两步，第一步将 PM-127图标（PM-127 Modbus Master V5.0或者 PM-127 Modbus Slave V5.0）拖到

左上方网络配置中，拖到 PROFIBUS DP总线之上，鼠标会变化形状，表示可以放入了。第二步是将位控制块

和数据块拖动到左下方数据映射表格中，表格会变成绿色，说明可以放入，使相应字节映射到 PLC内存。

注意：PROFIBUS DP从站的地址要与按扭的设置一致！

6. 设置 PROFIBUS DP 从站属性参数及相关 Modbus 命令 Module 参数，请参考 5.2.4 章节，保存并下载到

PLC。

4.2.4参数设置

在参数设置之前，我们需要了解 PM-127 Modbus Master V5.0、PM-127 Modbus Slave V5.0 各自作为

PROFIBUS DP从站的属性参数以及各自所支持的不同Module 的参数。

PM-127 Modbus Master
注册完 SIB_127M.gsd文件后，在目录中可找到该名称的设备，也就是说 PM-127在Modbus端作为Modbus

http://www.sibotech.net
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主站。

 PROFIBUS DP从站属性参数：

在组态界面，双击已拖动到 PROFIBUS DP网络上的 PM-127 Modbus Master V5.0，弹出的属性界面如下

图所示：

可配置的参数包括：

Baudrate（bps）：配置串口波特率，300、600、1200、2400、4800、9600、19200、38400、57600、115200bps

可选；

Data bits，Parity bit，Stop bits：配置数据位、检验方式以及停止位，8 None 1、8 Odd 1、8 Even 1、8 Mark

1、8 Space 1、8 None 2 可选；

Protocol Type：当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Master，则该项为“Modbus Master”；

当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Slave，则该项为“Modbus Slave”；

Response Timeout：当 Protocol Type 为Modbus Master时有效，100、200、300、400、500、600、700、

800、900、1000、1500、2000、3000、4000、5000ms可选；
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Delay Between Polls：当 Protocol Type 为Modbus Master时有效，No Delay、50、100、150、200、300、

400、500、600、700、800、900、1000、1500、2000ms可选；

Transmission Mode：配置Modbus通讯模式，RTU、ASCII可选；

Write Mode：配置输出方式，逢变输出（Change of Value）、连续输出(Cycle)可选；

Response Timeout Action：当 Response Timeout发生时的动作，保持数据（Hold Data）、清零（Clear Data）

可选；

Response Timeout for N times：当 Response Timeout发生时的重发次数，可设置范围 2-254；

Automatic demotion：自动降级（Automatic demotion）功能可选择开启或关闭；

Enter AD after N times Cmd Fail：当 Automatic demotion开启时有效，代表超时 N次后进入自动降级，

次数可以设置范围是 1-255；

Automatic demotion time（s）：当 Automatic demotion开启时有效，自动降级持续时间，可设置范围 1-3600，

单位为秒；

Scan rate（1~255）：快速/慢速扫描速度比率，设置范围 1-255；（例：Scan rate设为 3时，每有 3次快速

扫描，进行一次慢速扫描）

 Module 参数

在组态界面，双击已拖动到 PM-127对应的左下方表格中的Module，弹出的属性界面如下图所示：
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可配置的参数包括：

Slave Address：设置 PM-127所要连接的Modbus从站的地址，1～247可选；

Function：无需设置，功能码有各自对应的Module；

Starting Address：设置寄存器起始地址，0～65535可选。注意： Modbus协议命令的地址有两种格式：

协议地址(base 0)和 PLC地址(base 1)。此处需填写协议地址(base 0)格式。

例如：03命令 40100地址（PLC 地址(base 1)格式），此处填写 99（协议地址(base 0)格式）即可；
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No. of Points：数据个数，只有 01H、02H、0FH功能码对应的Module 需要设置数据个数。

 支持的Modbus 命令Module

PM-127作为Modbus Master时支持的Module包括：Control Module、Status Module、Read Module、Write

Module

Control Module：Control (8 Commands)～Control (48 Commands)

作为Modbus主站，用户可通过在 PROFIBUS端控制Modbus命令的发送，提供 6条控制Module供选择，

每个 PM-127只能被配置 1条控制Module。

注：若不需要控制Modbus命令，则不用组态控制Module，Modbus命令会自动发送。

Control (8 Commands)～Control (48 Commands)：6选 1，控制块的每个位（bit）控制 1条Modbus命令，

需要使能（使该命令生效）时需将对应的位（bit）置 1，不需要使能时置 0；

a) Control(8 Commands)；控制该该 Control Module所在槽位之后的 8条命令的发送，占用输出区 1个字

节；

b) Control (16 Commands)：控制该 Control Module 所在槽位之后的 16条命令的发送，占用输出区 2 个

字节；

c) Control (24 Commands)：控制该 Control Module 所在槽位之后的 24条命令的发送，占用输出区 3 个

字节；

d) Control (32 Commands)：控制该 Control Module 所在槽位之后的 32条命令的发送，占用输出区 4 个

字节；

e) Control (40 Commands)：控制该 Control Module 所在槽位之后的 40条命令的发送，占用输出区 5 个

字节；
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f) Control（48commands）：控制该 Control Module 所在槽位之后的 48条命令的发送，占用输出区 6个

字节；

注意：用户在添加控制块时，需将控制块添加在 Read Module以及Write Module所在槽位

的前面。

例如：

如果用户在实际使用过程中需要配置 7条命令（7个读写数据块），则可选择控制块“Control(8 Commands)”，

也就是选择的 Control Module控制的命令条数要大于或等于配置的命令条数。

假如 PROFIBUS DP主站槽位中的数据块如下所示：

网关上电后，假如 PROFIBUS DP端通讯正常（STA绿灯闪烁）。此时，用户需要给输出地址 QB0 赋值来

使能需要发出的命令。如果只需使能配置命令中的（Read 1-8bits（1xxxx））和（Read 8 Words（3xxxx））命令，

则只需要将输出区第 1个字节的第 1位（base 1）和第 4位（base 1）置 1，即将 QB0赋值为 9（0 0 0 0 1 0 0 1）。

Status Module：Status(8 Commands)～Status(48 Commands)、Exception Codes

作为Modbus主站，PROFIBUS端可以监视Modbus命令的状态，提供两种Modbus命令状态监视功能：

Status(8 Commands)～Status(48 Commands)：6选 1，每个位分别表示每条Modbus命令的状态，响应正确

时置位，响应异常、超时或错误计数达到 3次时清零，计数在响应正确时清零。

a) Status(8 Commands)：监视 8条命令；

b) Status(16 Commands)：监视 16条命令；

c) Status(24 Commands)：监视 24条命令；

d) Status(32 Commands)：监视 32条命令；

e) Status(40 Commands)：监视 40条命令；

f) Status(48 Commands)：监视 48条命令；

Exception Codes：为 1word Module，高字节表示Modbus命令索引 0 ~ 47；低字节表示异常代码或错误码。

当响应正确时错误码为 0；当响应异常、超时或错误时高字节最高位置位，异常代码来自从设备，响应超时或
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错误时错误码为 0xFF。

Read Module：Read 1-8 Bits（0xxxx）～Read 249-256 Bits（0xxxx）、Read 1-8 Bits（1xxxx）～Read 249-256

Bits（1xxxx）、Read 1 Words（4xxxx）～Read 64 Words（4xxxx）、Read 2 Words（4xxxx）Consistent～Read 16

Words（4xxxx）Consistent、Read 1 Words（3xxxx）～Read 64 Words（3xxxx）、Read 2 Words（3xxxx）Consistent～

Read 16 Words（3xxxx）Consistent

作为Modbus主站，支持的Modbus读命令Module如上所述，用户可根据需要拖动不同的Module并进行

简单相关设置即可。

Write Module：Write Single Bits（0xxxx）～Write 249-256 Bits（0xxxx）、Write Single Words（4xxxx）～

Write 64 Words（4xxxx）、Write 2 Words（4xxxx）Consistent～Write 16 Words（4xxxx）Consistent

作为Modbus主站，支持的Modbus写命令Module如上所述，用户可根据需要拖动不同的Module并进行

简单相关设置即可。

PM-127 Modbus Slave
注册完 SIB_127S.gsd文件后，在目录中可找到该名称的设备，也就是说 PM-127在Modbus端作为Modbus

从站。

 PROFIBUS DP从站属性参数：

在组态界面，双击已拖动到 PROFIBUS DP网络上的 PM-127 Modbus Slave V5.0，弹出的属性界面如下图

所示：
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可配置的参数包括：

Baudrate（bps）：配置串口波特率，300、600、1200、2400、4800、9600、19200、38400、57600、115200bps

可选；

Data bits，Parity bit，Stop bits：配置数据位、检验方式以及停止位，8 None 1、8 Odd 1、8 Even 1、8 Mark

1、8 Space 1、8 None 2 可选；

Protocol Type：当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Master，则该项为“Modbus Master”；

当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Slave，则该项为“Modbus Slave”；

Slave Address：当 Protocol Type 为Modbus Slave 时有效， 设置 PM-127 作为 Modbus从站的地址，1～

247可选。

Transmission Mode：配置Modbus通讯模式，RTU、ASCII可选；

 Module 参数

在组态界面，双击已拖动到 PM-127对应的左下方表格中的Module，弹出的属性界面如下图所示：
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其中：Function：当拖动某一Module时，Function 已经确定，表示该 Module支持的 Function包括

03H（3）、06H（6）、10H（16）。

 支持的Modbus 命令Module

PM-127作为Modbus Slave时支持的Module包括：Status Module、Input Module、Output Module

Status Module：Status

作为Modbus从站，PROFIBUS端可以监视Modbus网络状态，PROFIBUS端提供Modbus网络状态Module，

占一个字节，当从站收到一条正确请求时，状态字节加一。

Input Module：8 Bits Input（0xxxx）～128 Bits Input（0xxxx）、1 Word Input（4xxxx）～64 Words Input

（4xxxx）、2 Words Input（4xxxx）Consistent～16 Words Input（4xxxx）Consistent

作为Modbus从站，支持的Modbus读命令Module如上所述，用户可根据需要拖动不同的Module并进行

简单相关设置即可。

Output Module：8 Bits Input（1xxxx）～128 Bits Input（1xxxx）、1 Word Input（3xxxx）～64 Words Input

（3xxxx）、2 Words Input（3xxxx）Consistent～16 Words Input（3xxxx）Consistent

作为Modbus从站，支持的Modbus写命令Module如上所述，用户可根据需要拖动不同的Module并进行

简单相关设置即可。
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五、Modbus主、从站工作原理

5.1 Modbus主站工作原理

PM-127 Modbus Master的Modbus和 PROFIBUS之间的数据转换通过“映射”关系来建立。在 PM-127中有

两块数据缓冲区，一块是 PROFIBUS 网络输入缓冲区，另一块是 PROFIBUS 网络输出缓冲区。Modbus读取

命令将读取的数据写入到网络输入缓冲区，供 PROFIBUS网络读取。Modbus写寄存器类的命令从网络输出缓

冲区取数据，通过写命令输出到相应的Modbus设备。

支持 01H、02H、03H、04H、05H、06H、0FH、10H号功能码，用户可以配置 48条Modbus命令Module。

5.2 Modbus从站工作原理

PM-127 Modbus Slave 的Modbus和 PROFIBUS之间的数据转换通过“映射”关系来建立。在 PM-127 中

有两块数据缓冲区，一块是 PROFIBUS 网络输入 缓冲区，另一块是 PROFIBUS 网络输出 缓冲区。网络输

入和输出缓冲区都是相对于 PROFIBUS 而言的。Modbus写寄存器类命令将数据写入到网络输入缓冲区，供

PROFIBUS网络读取。Modbus读取命令从网络输出缓冲区取数据，通过响应报文传输给Modbus 主站设备。
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PROFIBUS
输入缓冲区

4xxxx

00000（40001）

00001（40002）

00002（40003）

… …

0xxxx

00000（00001）

00001（00002）

00002（00003）

… …

PROFIBUS
输出缓冲区

3xxxx

00000（30001）

00001（30002）

00002（30003）

… …

1xxxx

00000（10001）

00001（10002）

00002（10003）

… …

Modbus写命令：

06H和 10H
Modbus读命令：

03H

Modbus写命令：

05H和 0FH
Modbus读命令：

01H

Modbus读命令：
04H

Modbus读命令：
02H

支持Modbus寄存器地址 3区（3xxxx）、4区（4xxxx）、0区（0xxxx）和 1区（1xxxx）；其中，3区支持

功能码 04H；4区支持功能码 03H、06H、10H；0区支持功能码 01H、05H、0FH；1区支持功能码 02H；

PROFIBUS DP 输入缓冲区对于 Modbus一侧，是 Modbus 主站输出，映射到Modbus 保持寄存器 4xxxx

（使用 10H和 06H命令写入数据，使用 03H命令回读数据）和线圈 0xxxx（使用 0FH和 05H命令写入数据，

使用 01H命令回读数据）。

PROFIBUS DP输出缓冲区对于Modbus一侧，是Modbus主站输入，映射到Modbus输入寄存器 3xxxx（使

用 04H命令读取数据）和输入位 1xxxx（使用 02H命令读取数据）。

PM-127作为Modbus从站，支持使用功能码 04H，寄存器地址 5000（十进制协议地址），监控 PROFIBUS

DP端网络状态。当 PROFIBUS DP网络故障时，寄存器值被置 1；当 PROFIBUS DP网络正常时，寄存器值被

置 0。
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六、Step7如何读写网关数据

PM-127作为Modbus Master支持长度完整的Modbus命令Module如下所示：

Read 2 Words（4xxxx）Consistent～Read 16 Words（4xxxx）Consistent、Read 2 Words（3xxxx）Consistent～

Read 16 Words（3xxxx）Consistent、Write 2 Words（4xxxx）Consistent～Write16 Words（4xxxx）Consistent

PM-127作为Modbus Slave支持长度完整的Modbus命令Module如下所示：

2 Words Input（4xxxx）Consistent～16 Words Input（4xxxx）Consistent、2 Words Output（3xxxx）Consistent～

16 Words Output（3xxxx）Consistent

对于长度完整的Modbus命令Module，在 Step7 编程时须采用打包式发送与接收。打包式发送与接收主要

用到 SFC15（打包发送）和 SFC14（打包接收）。

SFC14

SFC15

对于长度完整之外的其它Modbus命令Module，在 Step7 编程时可以直接使用MOVE指令对数据进行读

写(推荐)。
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七、安装

7.1机械尺寸

尺寸： 25mm（宽）×100mm（高）×90mm（深）

7.2安装方法

35mm DIN导轨安装
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八、运行维护及注意事项

 模块需防止重压，以防面板损坏。

 模块需防止撞击，有可能会损坏内部器件。

 供电电压控制在说明书的要求范围内，以防模块烧坏。

 模块需防止进水，进水后将影响正常工作。

 上电前请请检查接线，有无错接或者短路。
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九、版权信息

本说明书中提及的数据和案例未经授权不可复制。泗博公司在产品的发展过程中，有可能在不通知用户

的情况下对产品进行改版。

是上海泗博自动化技术有限公司的注册商标。

该产品有许多应用，使用者必须确认所有的操作步骤和结果符合相应场合的安全性，包括法律方面，规章，

编码和标准。
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十、修订记录

时间 修订版本 修改内容

2024-11-27 B 新增Modbus寄存器地址填写示例

2021-5-18 V6.0 A 增加隔离电源和终端电阻

2020-4-20 A 初始版本。

上海泗博自动化技术有限公司
SiboTech Automation Co., Ltd.
技术支持热线：021-3126 5138
E-mail: support@sibotech.net
网址：www.sibotech.net

http://www.sibotech.net
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www.sibotech.net 38

附录 A：如何在 TIA Portal中组态 PM-127

1. 创建新工程

1.1 打开 TIA Portal 软件 ，如图 1所示：

图 1打开 TIA Portal
1.2. 左侧点击“创建新项目”，可在右边界面设置项目名称，保存路径等选项，点击“创建”便可建立一

个新的项目，如图 2所示：
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图 2创建新项目

1.3 创建完成进入如下界面，在窗口中双击“组态设备”如图 3，在新的窗口左侧点击“添加新设备”并在

右侧选择PLC设备型号，以S7-300为例，设定CPU模块，选择对应的设备类型：PLC > SIMATIC S7 -300 >

CPU > CPU 315-2 DP > 6ES7 315-2AG10-0AB0，然后点击右下角“添加”，如图 4所示：
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图 3组态设备

图 4添加 CPU

图 5 CPU在设备视图界面显示

2.导入 GSD文件

2.1 PM-127网关串口端作为Modbus主站和从站的 GSD文件不同，请根据需要导入正确的 GSD文件，在软

件上方点击：选项 > 安装设备描述文件（GSD），如图 6所示：
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图 6 GSD文件的安装

2.2 在弹出的窗口中，单击右侧 按键，浏览文件夹寻找到 PM-127的 GSD文件，点击“确定”便可将

GSD文件添加到窗口中（注意：GSD所在的文件夹的名称不能包含汉字，否则会导入 GSD失败），如

图 7所示：
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图 7选择 GSD文件路径

2.3 在 GSD文件前小方框中勾选要导入的 GSD文件，点击右下方“安装”，确认安装 GSD 文件后需重启 TIA

Portal软件，然后点击“确定”，GSD文件开始安装，如图 9所示，安装完成后显示消息“安装已成功完

成”，然后点击窗口下方“关闭 TIA Portal”，会弹出“更新硬件目录”的窗口，如图 11所示：

图 8勾选需要安装的 GSD文件
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图 9正在安装 GSD文件

图 10 GSD文件安装成功
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图 11更新硬件目录

3.硬件组态设置

3.1 GSD文件安装更新完成后，重新打开 TIA Portal，选中前面建立的 PM-127项目，点击右下方“打开”，

双击“组态设备”；双击“PLC-1” 进入硬件组态界面，如下图所示：
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图 12打开 PM-127项目

图 13选择 PLC设备

3.2添加电源模块，在右侧目录窗口中选择 PS > PS 307 5A > 6ES7 307-1EA00-0AA0，双击或拖动将电源添

加到机架上，如图 14所示：
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图 14添加电源模块

3.3 在项目窗口中点击右上角的网络视图：

图 15网络视图

http://www.sibotech.net


www.sibotech.net 47

3.4 在右侧目录窗口中添加 PM-127网关，选择 其他现场设备 > PROFIBUS DP >常规 > Sibotech Automation

Co.,Ltd > CONVERTER > PM127 Modbus Master V5.0>PM127双击或拖动添加 PM-127，如图 16所示：

图 16添加 PM-127

3.5 右击 PLC 上的红色小方块，在弹出的小窗口中点击“添加子网”，PLC下方出现 DP总线；再点击 Slave-1

从站上蓝色“未分配”字样，提示“选择主站”，点击“PLC-1.DP 接口-1”即可，如图 17、18所示，此

时 PLC与从站显示已经建立连接，如图 19所示：

图 17添加子网
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图 18连接主站

图 19 建立连接

3.6 以 PM-127的串口端做Modbus主站为例，点击从站中 DP NORM部分可在窗口下方对 PM-127进行配置，

设置 PROFIBUS DP从站地址、常规 DP地址、设备专用参数等数据，如图 20所示；

可配置的参数包括：

Baudrate（bps）：配置串口波特率，300、600、1200、2400、4800、9600、19200、38400、57600、115200bps

可选；

Data bits，Parity bit，Stop bits：配置数据位、检验方式以及停止位，8 None 1、8 Odd 1、8 Even 1、8 Mark

1、8 Space 1、8 None 2 可选；
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Protocol Type：当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Master，则该项为“Modbus Master”；

当拖动到 PROFIBUS DP总线上的是 PM-127 Modbus Slave，则该项为“Modbus Slave”；

Response Timeout：当 Protocol Type 为Modbus Master时有效，100、200、300、400、500、600、700、

800、900、1000、1500、2000、3000、4000、5000ms可选；

Delay Between Polls：当 Protocol Type 为Modbus Master时有效，No Delay、50、100、150、200、300、

400、500、600、700、800、900、1000、1500、2000ms可选；

Transmission Mode：配置Modbus通讯模式，RTU、ASCII可选；

Write Mode：配置输出方式，逢变输出（Change of Value）、连续输出(Cycle)可选，；

图 20 网关Modbus端设置参数信息

3.7从站参数设置完成，添加输入/输出数据块，点击项目窗口右上方“设备视图”，在左上方选择设备窗口中

选择从站 Slave-1 即 PM-127，此时可从右侧目录窗口中选择输入输出数据块，双击或将需要的数据快添加

到设备概览窗口的槽位中。在下方常规窗口中，单击“Read 1-8 Bits(0xxxx)_1”的读线圈的数据块，会显

示数据块的常规参数，如下图 22所示。

可配置的参数包括：

Slave Address：设置 PM-127所要连接的Modbus从站的地址，1～247可选；
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Function：无需设置，功能码有各自对应的Module；

Starting Address：设置寄存器起始地址，0～65535 可选（十进制协议地址）。注意： Modbus协议命令

的地址有两种格式：协议地址(base 0)和 PLC地址(base 1)。此处需填写协议地址(base 0)格式。

例如：03命令 40100地址（PLC地址(base 1)格式），此处填写 99（协议地址(base 0)格式）即可；

No. of Points：数据个数，只有 01H、02H、0FH功能码对应的Module需要设置数据个数。

图 21设置输入输出字节数
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图 22读数据块设置

单击“Write 8 Words(4xxxx)_1”写寄存器的数据块，会显示数据块的常规参数，如图 23所示。

可配置的参数包括：

Slave Address：设置 PM-127所要连接的Modbus从站的地址，1～247可选；

Function：无需设置，功能码有各自对应的Module；

Starting Address：设置寄存器起始地址，0～65535可选（十进制协议地址）；

备注：读写寄存器数据块的长度代表要读写的连续寄存器地址的个数。

图 23 写数据块设置

4.编译
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硬件组态完成后，点击工具栏中编译按钮 ，进行编译，编译成功后可点击编译按钮旁的下载按钮

下载工程到设备中，如图 24所示：

图 24 编译下载
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附录 B：Modbus协议

Modbus-RTU协议:
说明：与本产品通讯的设备必须带有Modbus接口，同时设备Modbus协议必须符合下面的规定，本公司提供

用户定制服务。

1.协议概述

物理层：传输方式：RS485
通讯地址：0-247
通讯波特率：可设定

通讯介质：屏蔽双绞线

传输方式：主从半双工方式

协议在一根通讯线上使用应答式连接（半双工），这意味着在一根单独的通讯线上信号

沿着相反的两个方向传输。首先，主计算机的信号寻址到一台唯一的终端设备（从机），然后，在相反的方向

上终端设备发出的应答信号传输给主机。

协议只允许在主计算机和终端设备之间，而不允许独立的设备之间的数据交换，这就不会在使它们初始

化时占据通讯线路，而只响应到达本机的查询信号。

一个数据帧格式：

1位起始位，8位数据，1位停止位。

一个数据包格式

地址 功能码 数据 校验码

8-Bits 8-Bits N x 8-Bits 16-Bits

协议详细定义了校验码、数据序列等，这些都是特定数据交换的必要内容。

当数据帧到达终端设备时，它通过一个简单的“口”进入寻址到的设备，该设备去掉

数据帧的“信封”（数据头），读取数据，如果没有错误，就执行数据所请求的任务，然后，它将自己生成的数

据加入到取得的“信封”中，把数据帧返回给发送者。返回的响应数据中包含了以下内容：终端从机地址

(Address)、被执行了的命令(Function)、执行命令生成的被请求数据(Data)和一个校验码(Check)。发生任何错误

都不会有成功的响应。

地址（Address）域

地址域在帧的开始部分，由 8位（0 ~ 255）组成，这些位标明了用户指定的终端设备

的地址，该设备将接收来自与之相连的主机数据。每个终端设备的地址必须是唯一的，仅仅被寻址到的终端

会响应包含了该地址的查询。当终端发送回一个响应，响应中的从机地址数据便告诉了主机哪台终端正与之

进行通信。

功能（Function）域

功能域代码告诉了被寻址到的终端执行何种功能。表 1 – 1列出了所有的功能码、它们的意义及它们的初

始功能。
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表 1 – 1 功能码

代码 意义 行为

03 读数据 获得一个或多个寄存器的当前二进制值

06 预置单寄存器 放置一个特定的二进制值到一个单寄存器中

16 预置多寄存器 放置特定的二进制值到一系列多寄存器中

数据域

数据域包含了终端执行特定功能所需要的数据或者终端响应查询时采集到的数据。这

些数据的内容可能是数值、参考地址或者极限值。例如：功能域码告诉终端读取一个寄存器，数据域则需要

指明从哪个寄存器开始及读取多少个数据，内嵌的地址和数据依照类型和从机之间的不同能力而有所不同。

错误校验域

该域允许主机和终端检查传输过程中的错误。有时，由于电噪声和其它干扰，一组数

据在从一个设备传输到另一个设备时在线路上可能会发生一些改变，出错校验能够保证主机或者终端不去响

应那些传输过程中发生了改变的数据，这就提高了系统的安全性和效率，出错校验使用了 16位循环冗余的方

法。

[注] 发送序列总是相同的 – 地址、功能码、数据和与方向相关的出错校验。

错误检测

循环冗余校验（CRC）域占用两个字节，包含了一个 16位的二进制值。CRC值由传

送设备计算出来，然后附加到数据帧上，接收设备在接收数据时重新计算 CRC值，然后与接收到的 CRC域

中的值进行比较，如果这两个值不相等，就发生了错误。

CRC运算时，首先将一个 16位的寄存器预置为全 1，然后连续把数据帧中的 8位字节

与该寄存器的当前值进行运算，仅仅每个字节的 8个数据位参与生成 CRC，起始位和终止位以及可能使用的

奇偶位都不影响 CRC。
在生成 CRC时，每个 8位字节与寄存器中的内容进行异或，然后将结果向低位移位，高位则用“0”补充，

最低位（LSB）移出并检测，如果是 1，该寄存器就与一个预设的固定值进行一次异或运算，如果最低位为 0，
不作任何处理。

上述处理重复进行，知道执行完了 8次移位操作，当最后一位（第 8位）移完以后，下一个 8位字节与

寄存器材的当前值进行异或运算，同样进行上述的另一个 8次移位异或操作，当数据帧中的所有字节都作了

处理，生成的最终值就是 CRC值。

生成一个 CRC的流程为：

预置一个 16位寄存器为 0FFFFH（全 1），称之为 CRC寄存器。

把数据帧中的第一个 8位字节与 CRC寄存器中的低字节进行异或运算，结果存回 CRC寄存器。将 CRC寄存

器向右移一位，最高位填以 0，最低位移出并检测。

如果最低位为 0：重复第三步（下一次移位）。

如果最低位为 1：将 CRC寄存器与一个预设的固定值（0A001H）进行异或运算。

重复第三步和第四步直到 8次移位。这样处理完了一个完整的八位。

重复第 2步到第 5步来处理下一个八位，直到所有的字节处理结束。

最终 CRC寄存器得值就是 CRC的值。

2．应用层功能详解

第一章已经简述了协议和数据帧，使用此软件的程序员可以使用下述的方法以便通过协议正确的建立他

们的特定应用程序。
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本章所述协议将尽可能的使用如图 2 – 1 所示的格式，（数字为 16进制）。

地址 功能码 变量起始地

址高字节

变量起始

地址低字节

变量的个

数高字节

变量的个

数低字节

校对验码

低字节

校对验码

高字节

03H 03H 00H 01H 00H 03H 55H E9H
图 2 – 1 协议例述

读数据（功能码 03）
查询

图 2 – 2 的例子是从 03号从机读 3个采集到的基本数据U1,U2,U3, U1的地址为 0001H, U2的地址为 0002H, U3
的地址为 0003H,

地址 功能码 变量起始

地址高字节

变量起始

地址低字节

变量的个

数高字节

变量的个

数低字节

校对验码

低字节

校对验码

高字节

03H 03H 00H 01H 00H 03H 55H E9H
图 2 – 2 读 Uca和 Ia 的查询数据帧

响应

响应包含从机地址、功能码、数据的数量和 CRC错误校验。

图 2 – 3的例子是读取 U1,U2,U3的响应。

地址 功能

码

变量

的总

字节

数

变量

值高

字节

变量

值低

字节

变量

值高

字节

变量

值低

字节

变量

值高

字节

变量

值低

字节

校对

验码

低字

节

校对

验码

高字

节

03H 03H 06H 01H 7CH 01H 7DH 01H 7CH F9H 9BH
图 2 – 3读 U1,U2,U3 的响应数据帧

2．2 预置多寄存器（功能码 10）
查询

功能码 10H允许用户改变多个寄存器的内容，设备可从任何地址开始设置最多 16个变量的值。控制器是

以动态扫描方式工作的，任何时刻都可以改变寄存器内容。

图 2-4是修改 3号从站设备的负载监控 1和负载监控 2的动作及延时时间的设定值，其中负载监控 1的动作设

定值地址为 2AH，延时时间的设定值为 2BH，负载监控 2的动作设定值地址为 2CH，延时时间的设定值为 2DH。
地址 功能

码

变量

起始

地址

高字

节

变量

起始

地址

低字

节

变量

的个

数高

字节

变量

的个

数低

字节

变量

的总

字节

数

变量

值高

字节

变量

值低

字节

变量

值高

字节

变量

值低

字节

变量

值高

字节

变量

值低

字节

变量

值高

字节

变量

值低

字节

校对

验码

低字

节

校对

验码

高字

节

03H 10H 00H 2AH 00H 04H 08H 07H D0H 00H 0AH 07H 0D0H 00H 0AH 25H 7CH
图示 2-4修改负载监控 1和负载监控 2的动作值及延时时间的设定值

响应

地址 功能码 变量起始

地址高字节

变量起始

地址低字节

变量的个

数高字节

变量的个

数低字节

校对验码

低字节

校对验码

高字节

03 10H 00H 2AH 00H 04H EBH 8DH
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图示 2-5 修改负载监控 1和负载监控 2的动作值及延时时间的设定值的响应

2．3 预置单寄存器（功能码 06）
查询

功能码06允许用户改变单个寄存器的内容，DAE系统内部的任何单寄存器都可以使用此命令来改变其值。

既然仪器是以动态扫描方式工作的，任何时刻都可以改变单寄存器内容。

下面的例子是请求 03号从机修改过载动作设定值 Ir1，Ir1地址是 002EH.

地址 功能码 变量起始

地址高字节

变量起始

地址低字节

变量值

高字节

变量值低

字节

校对验码

低字节

校对验码

高字节

03H 06H 00H 2EH 07H 0D0H EBH 8DH
图示 2-6 修改过载动作设定值 Ir1

响应

对于预置单寄存器请求的正常响应是在寄存器值改变以后将接收到的数据传送回去。

地址 功能码 变量起始

地址高字节

变量起始

地址低字节

变量值高

字节

变量值低

字节

校对验码

低字节

校对验码

高字节

03H 06H 00H 2EH 07H 0D0H EBH 8DH
图示 2-7 修改过载动作设定值 Ir1
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